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Einleitung 
OtsDJ eröffnet ein neues Zeitalter der DJ- und Radio-Automationssoftware und ermöglicht nicht nur 
allen Musikliebhabern, ihre Lieblingsstücke selber abzumischen, sondern auch professionellen DJ's, 
sich auf wichtigere Bereiche der Kreativität zu konzentrieren, die sie von der breiten Masse abheben. 
 
Das vorliegende Quick Start-Handbuch soll Ihnen helfen, OtsDJ schnell und effizient zu installieren 
und zu benutzen. Weitere Informationen zu den Eigenschaften und Funktionen von OtsDJ finden Sie in 
der OtsDJ Online-Hilfe auf der Website: http://OtsDJ.com/doc/ 
 
 

http://OtsDJ.com/doc/
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Setup 
Dieser Abschnitt beschreibt die Systemanforderungen sowie die Installation und Lizensierung von 
OtsDJ. 
 
Systemanforderungen 
Dank seines intelligenten und schlanken Konzepts benötigt das komplette OtsDJ-Softwarepaket nur 
sehr wenig Speicherplatz (ca. 4 MB) und läuft problemlos, wenn die folgenden Mindest-
Systemanforderungen erfüllt werden:  

• Betriebssystem: Microsoft Windows 95, 98, ME, 2000 oder XP. 
• CPU: Pentium II 233 MHz oder höher (empfohlen: Pentium III 500 MHz oder höher). 
• RAM: 64 MB oder mehr. 
• Soundkarte: Soundkarte mit DirectSound oder WDM-Treibern. 
• Grafikkarte: Beste Ergebnisse erzielen Sie mit einer Grafikkarte mit mindestens 16-bit "hi-

color"-Modus. Eine Bildschirmauflösung von 800 x 600 wird empfohlen. 
• CD-ROM: Um die CD Digital Audio-Funktion zu nutzen, benötigen Sie ein CD-ROM-

Laufwerk, das in der Lage ist, CD-DA Streams präzise zu lesen (die meisten in den letzten Jahren 
hergestellten Modelle sind hierfür geeignet). 

 
Wenn Sie beabsichtigen, ein neues Computersystem zu kaufen, finden Sie in der OtsDJ Online-Hilfe 
einige Empfehlungen. 
 
 
OtsDJ Installation 
Das Ots-Anwendungspaket wurde mit einem einzigartigen, schnellen und effizienten 
Installationsprogramm namens OtsSetup ausgestattet. Sie werden überrrascht sein, wie schnell und 
unkompliziert der Installationsvorgang abläuft.  
 
 
Installation der OtsDJ Demo 

• Klicken Sie doppelt auf die Installationsdatei OtsDJDemosetup.exe.  
• Im OtsSetup - OtsDJ Demo-Dialogfenster klicken Sie auf Next --->. 
• Lesen Sie das OTS CORPORATION SOFTWARE LICENSE AGREEMENT 

(Lizenzvereinbarung). Wenn Sie die Bedingungen akzeptieren, klicken Sie auf I Accept --->. 
• Klicken Sie auf den Begin Installing Files --->. 
• Im Anschluss klicken Sie im Fenster Installation Successful auf Next --->. 
• Möglicherweise müssen Sie Ihr System neu starten. Vergewissern Sie sich, dass die Option  

Restart markiert wurde und klicken Sie auf Finish. 
• Bitte lesen Sie den Text im Important Audio Information-Fenster und klicken Sie auf OK. 
• Hierauf wird das Select "On-Air" Output Device-Dialogfenster eingeblendet.  
• Wählen Sie Ihren Standard-Soundkartentreiber und klicken Sie auf OK. Weitere 

Informationen zur Soundkarten-Kompatibilität finden Sie in der OtsDJ Online-Hilfe. 
Hinweis: Wir empfehlen Ihnen, sich die interaktive OtsDJ-Tour anzuschauen. 

 
 
OtsDJ installieren 

• Klicken Sie doppelt auf OtsDJsetup.exe. 
• Im OtsSetup - OtsDJ-Dialogfenster klicken Sie auf Next --->. 
• Lesen Sie das OTS CORPORATION SOFTWARE LICENSE AGREEMENT 

(Lizenzvereinbarung). Wenn Sie die Bedingungen akzeptieren, klicken Sie auf I Accept --->. 
• Klicken Sie auf Begin Installing Files --->. 
• Im Anschluss wird das Installation-Successful-Dialogfenster eingeblendet. Klicken Sie auf 

Next --->. 
• Möglicherweise müssen Sie Ihr System neu starten. Vergewissern Sie sich, dass die Option  

Restart markiert wurde und klicken Sie auf Finish.  
• Nun müssen Sie OtsDJ lizensieren. Beachten Sie hierzu den Abschnitt OtsDJ lizensieren.    
• Hierauf wird das Select "On-Air" Output Device-Dialogfenster eingeblendet.  
• Wählen Sie Ihren Standard-Soundkartentreiber und klicken Sie auf OK. Weitere 

Informationen zur Soundkarten-Kompatibilität finden Sie in der OtsDJ Online-Hilfe. 
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OtsDJ lizensieren 
OtsDJ, das Ots Scheduling & Logging-Modul und Ots Studio Professional verwenden das OtsReg 
Lizenzsystem. Für die Lizensierung dieses Systems sind zwei Komponenten erforderlich: die 
Produktlizenz und eine gültige Systemlizenz. 
 
Die Produktlizenz ist in der OtsDJ license E-Mail enthalten, die Sie erhalten, wenn Sie die OtsDJ-
Lizenz auf der Website http://OtsZone.com kaufen. 
 
Die Systemlizenz erhalten Sie automatisch von einem OtsZone.com-Server (für Systeme mit 
Internetanbindung) oder manuell (für Systeme ohne Internetanbindung). Die Systemlizenz wird 
individuell für jedes System ausgestellt. 
 
Hinweise zum Erhalt einer Systemlizenz für Systeme ohne Internetanbindung erhalten Sie in der OtsDJ 
Online-Hilfe. 
  
Weitere Informationen zum OtsReg-Lizenzsystem erhalten Sie unter  
http://OtsZone.com/info/otsreg.html 
 
 
Lizensierung eines Systems mit Internetanbindung 
Hinweis: Das im folgenden Abschnitt beschriebene Lizensierungs-Verfahren ist für Ots Studio 
Professional und das Ots Scheduling & Logging-Modul erforderlich. Das Scheduling & Logging-
Modul erfordert eine eigene Lizenz.  

• Installieren Sie OtsDJ und starten Sie Ihren Computer neu. 
• Öffnen Sie OtsDJ. 
• Hierdurch wird das OtsReg-Dialogfenster eingeblendet. Wenn das Fenster nicht eingeblendet 

wird, öffnen Sie Help -> licensing Information in der OtsDJ Menüleiste. 
• Klicken Sie auf Enter/Edit. Hierdurch wird das Enter/Edit Product License Dialogfenster 

eingeblendet. 
• Kopieren Sie Ihre Produktlizenz und fügen Sie diese in das Product License-Textfeld ein (Ihre 

Produktlizenz finden Sie in Ihrer OtsDJ License-E-Mail oder auf OtsZone.com). Die 
Produktlizenz besteht aus insgesamt 9 Textzeilen. Alle neun Textzeilen müssen kopiert und 
eingefügt werden. Beachten Sie hierzu auch das folgende Beispiel. 

  
Beispiel für eine Produktlizenz: 
 
+++++ BEGIN OtsZone Product License +++++ 
Product=OtsDJ 
Version=1.0 
Quantity=1 
Name=Michael Jackson 
Company= 
PDI=PAAA-ABCZ 
PL=L-2SHE-ECW4-P4HE-1HX3-7R25-JK3R-23XS-4QTH 
+++++ END OtsZone Product License +++++  

 
• Klicken Sie auf OK. 
• Als nächstes benötigen Sie eine Systemlizenz. Klicken Sie auf den Obtain Button. 
• Klicken Sie auf Automatically get machine license now.  
• Klicken Sie auf OK.   
• Klicken Sie auf Run Application. 

  
 
Beispiel für eine Systemlizenz: 
Die Systemlizenz besteht aus einer einzelnen Textzeile. 
 
M-14W3-K2ZP-R8L5-WPWT-WES2-FJHF-GMW3-6CDP  
 
  

http://OtsZone.com
http://OtsZone.com/info/otsreg.html
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Medien-Formate 
OtsDJ kann Wave und MP3-Dateien direkt abspielen, ohne diese vorher in das Ots Album-Format zu 
konvertieren. Obwohl Ihnen diese Funktionalität die Möglichkeit bietet, OtsDJ schnell zu starten und 
die gewünschte Mediensammlung abzuspielen, werden Sie feststellen, dass Ihnen das Ots Album-
Format mehr Funktionen und Flexibilität bietet. Wir empfehlen unseren Kunden, ihre Sammlung in das 
Ots Album-Format zu konvertieren; dies ist jedoch nicht unbedingt erforderlich. Informationen zu den 
Ots-Dateikonvertierungstools finden Sie in den folgenden Abschnitten. Weitere Informationen zum Ots 
Album-Dateiformat finden Sie in der OtsDJ Online-Hilfe. 
 
OtsDJ kann die folgenden Medienformate wiedergeben: 

• Ots Album-Dateien 
• Wave-Dateien 
• MP3-Dateien 
• Audio CD's 

  
 
Vorbereitung Ihrer Mediensammlung 
Bevor Sie Ihre Mediensammlung in OtsDJ laden, empfehlen wir Ihnen dieselbe vorzubereiten. 
Hierdurch können Sie mit geringem Arbeitsaufwand bei zukünftigen Anwendungen viel Zeit sparen. 
  
 
Vorbereitung von MP3-Dateien 
OtsDJ erkennt entweder ID3v1-Tag Informationen einer  MP3-Datei oder verwendet den MP3-
Dateinamen zur Kennzeichnung und Einordnung. Wir empfehlen Ihnen, sich zu vergewissern, dass 
Ihre MP3-Dateien über die korrekten ID3v1-Tag Informationen verfügen oder der Dateiname dem 
üblichen Standard entspricht: Interpret-Titel.mp3. 
Hinweis: Wenn Ihre MP3 ID3v1-Tags Informationen zum Genre oder Erscheinungsdatum enthalten, 
können Sie Ihre MP3-Dateien schnell und einfach auf der Grundlage dieser Informationen sortieren.  
Klicken Sie hier, um weitere Informationen hierzu zu erhalten. 
  
 
Vorbereitung Ihrer Wave-Dateien 
OtsDJ erkennt den Wave-Dateinamen und nutzt diesen zur Kennzeichnung. Wir empfehlen Ihnen, sich 
zu vergewissern, dass die Wave-Dateinamen dem folgenden Standard entsprechen: Interpret-
Titel.wav. 
  
 
Konvertierung von Medien in das Ots Album-Dateiformat 
Wir bieten Ihnen zwei Tools zur Konvertierung von Mediendateien in das Ots Album-Dateiformat: Ots 
Studio und den Ots MP3 Convertor. Wir empfehlen unseren Kunden, Ihre Dateien, wenn möglich in 
das Ots-Dateiformat zu konvertieren, da dasselbe zahlreiche Vorteile bietet. Weitere Informationen 
zum Ots Album-Dateiformat finden Sie in der OtsDJ Online-Hilfe. 
  

Ots Studio Icon 
 

 
  
Mit der in OtsDJ enthaltenen Ots Studio-Anwendung können Sie Ihre CD's einfach und effizient 
rippen und in das Ots Album-Dateiformat konvertieren. Des Weiteren bietet Ihnen diese Anwendung 
die Möglichkeit, MP3- und Wave-Dateien in Ots Album-Dateien umzuwandeln. Weitere 
Informationen zu Ots Studio finden Sie in der Ots Studio Online-Hilfe. 
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Ots MP3 Convertor Icon 
 

 
 
Mit dem Ots MP3 Convertor können Sie MP3-Dateien direkt in das Ots-Dateiformat konvertieren. 
Informationen zur Verwendung des Ots MP3 Convertor finden Sie in der Online-Hilfe. 
 
 
Media Library 
OtsDJ Media Library ist ein leistungsfähiges aber einfach anzuwendendes Sortierungssystems, das 
Ihnen die Kategorisierung Ihrer Medienswammlung ermöglicht. Media Library sammelt Informationen 
zu jedem Objekt, z.B. Kategorien, Bewertung, BPM, letztes Abspieldatum und Kommentare. 
 
OtsDJ verfügt über eine eigene effiziente Suchsprache: Ots Media Query Language (OMQL), die 
das Abspeichern und Durchsuchen des Inhalts der Media Library erleichtert. Im Zusammenhang mit 
den in der Media Library gespeicherten Informationen bietet OMQL vielfältige Möglichkeiten der 
Kategorisierung und Erstellung von Play-Listen. Weitere Informationen zur Ots Media Query 
Language (OMQL) finden Sie in der OtsDJ Online-Hilfe. 
 
Die Media Library wird auf der Festplatte als Ots Media Library (.OML)-Datei gespeichert. Der 
voreingestellte Dateiname ist OtsDJ.oml. Diese Datei wird automatisch bei jedem Start von OtsDJ 
geladen. Sie haben darüber hinaus die Möglichkeit, andere OML-Dateien zu öffnen und zu speichern 
und mehr als eine Media Library auf dem gleichen System zu verwalten. Diese Option bietet den 
meisten Benutzern jedoch keine Vorteile und führt häufig zu Verwirrung. 
 
Wir empfehlen Ihnen, ein regelmäßiges Backup Ihrer Media Library-Datei durchzuführen. Wenn die 
Datei verloren geht oder zerstört wird, verlieren Sie alle zusätzlichen Informationen, die Sie zu den 
einzelnen Objekten eingegeben haben. Weitere Informationen zum Backup Ihrer Media Library finden 
Sie in der OtsDJ Online-Hilfe. 
 
Wenn Sie OtsDJ zum ersten Mal verwenden oder eine ausführliche Beschreibung der Media 
Library erhalten möchten, lesen Sie hierzu bitte die OtsDJ Online-Hilfe. 

Um den OtsDJ Media Library-Bereich anzuzeigen, klicken Sie auf das  Symbol in der Tool-
Leiste. 
 
 
Erstellung Ihrer Media Library 
Die Erstellung Ihrer Media Library erfolgt in drei grundlegenden Schritten: 

1) Importieren Ihrer Mediendateien in die Media Library. Beachten Sie hierzu die Anweisungen 
weiter unten. 

 
2) Erstellung/Verwaltung der Kategorien. Beachten Sie hierzu die Anweisungen weiter unten. 

 
3) Einordnung der Alben und Objekte in die Kategorien. Beachten Sie hierzu die Anweisungen 

weiter unten. 
 
Heißer Tipp: Wenn Sie Ihre Mediendateien in die Ordner der Kategorien auf Ihrer Festplatte 
einsortiert haben, können Sie in der Media Library die erstellte Struktur ganz einfach ändern. Lesen Sie 
hierzu den Abschnitt "Einordnung auf der Grundlage der Ordnerstruktur" weiter unten. 
 
 
Importieren von Dateien in Media Library 
Damit OtsDJ die Mediendateien wiedergeben kann, müssen diese zunächst in die Media Library 
importiert werden. Dateien können mithilfe des Tools Import/Refresh Files to Media Library in die 
Media Library importiert werden, während OtsDJ geöffnet ist.
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Zurzeit können die folgenden Mediendateien importiert und mit OtsDJ wiedergegeben werden: 
• Ots Album-Dateien 
• Wave-Dateien 
• MP3-Dateien 

 
Die aktuelle Version von OtsDJ kann Wave- und MP3-Dateien direkt abspielen, ohne dass diese vorher 
in das Ots-Dateiformat konvertiert werden müssen. Dank dieser Kompatibilität können Sie Ihre 
Mediensammlung (sofern diese aus MP3- und Wave-Dateien besteht) schnell und einfach mit OtsDJ 
abspielen.  
 
Während des Importierens werden Ihre Wave- und MP3-Dateien von OtsDJ für eine effiziente 
Verarbeitung analysiert. Die entsprechenden Informationen werden in den Media Library-Dateien und 
in Ots Media Extension (.OMX) gespeichert. Die .OMX-Datei wird in dem gleichen Ordner 
gespeichert wie die entsprechenden Wave- oder MP3-Dateien. 
 
Hinweis: Das Importieren der einzelnen Wave- und  MP3-Dateien nimmt aufgrund der zu 
erkennenden, zu analysierenden und zu speichernden Daten ein wenig Zeit in Anspruch. Dieser 
Vorgang ist für jede Datei nur einmal nötig, da die Informationen gleichermaßen in der Media Library 
und der entsprechenden .OMX-Datei gespeichert werden.  
  
Um das Dialogfenster Import/Refresh Files to Media Library zu öffnen, klicken Sie auf das 

Symbol in der Tool-Leiste. 
  
Import/Refresh Files...: Mit dieser Funktion können Sie bestimmte Dateien importieren. Sofern eine 
oder mehrere der ausgewählten Dateien bereits importiert wurden, werden diese aktualisiert, sofern sie 
seit der letzten Aktualisierung oder dem letzten Import geändert wurden. 
 
Import/Refresh Folder...: Mit dieser Funktion können Sie bestimmte Dateien importieren. Sofern eine 
oder mehrere der ausgewählten Dateien importiert wurden, werden diese aktualisiert, sofern sie seit der 
letzten Aktualisierung oder dem letzten Import geändert wurden. 
 
Easy Scan...: Mit dieser Funktion werden der MyMusic-Ordner (im OTS MP3 Convertor festgelegt) 
und alle anderen Ordner, die von Media Library referenzierte Dateien enthalten, gescannt. Alle darin 
enthaltenen Unterordner werden ebenfalls gescannt. 
 
Re-link Unavailable Albums (Files)...: Mithilfe dieser Funktion können Sie nach Dateien suchen, die 
verschoben oder umbenannt wurden und für die daher ein neuer Link zu den Einträgen in Media 
Library erstellt werden muss. Darüber hinaus aktualisiert und importiert diese Funktion auch andere 
Dateien. 
 
  
Importieren und Aktualisieren von Dateien 
Mithilfe dieser Funktion können Sie einzelne Dateien importieren. Dies kann hilfreich sein, wenn Sie 
nur eine geringe Anzahl von Dateien importieren (oder aktualisieren) wollen und vermeiden möchten, 
dass auch andere Dateien in den erstellten Ordnern gespeichert werden. 

• Klicken Sie auf das  Symbol in der Tool-Leiste. 
• Im Dialogfenster Import/Refresh Files to Media Library, klicken Sie auf den  

Import/Refresh... File(s). 
• Suchen Sie den Ordner, der Ihre Dateien enthält (der voreingestellte Ordner für Ihre Ots Album-

Dateien ist C:\OtsLabs\OtsFiles\MyMusic). 
• Klicken Sie auf die Datei(en). 
• Klicken Sie auf OK. 

  
Daraufhin passiert folgendes: 

• Ihre Ots Album-, Wave- und MP3-Dateien werden gescannt und in die Media Library importiert. 
• Das Import/Refresh Files Summary-Dialogfenster wird eingeblendet und bietet eine Übersicht 

über den Import-Vorgang. 
• Die importierten Dateien werden der Media Library hinzugefügt. 
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• Sofern eine oder mehrere der ausgewählten Dateien bereits importiert wurden, werden diese 
aktualisiert, sofern sie seit der letzten Aktualisierung oder dem letzten Import geändert wurden. 

 
Hinweis: Das Importieren der einzelnen Wave- und MP3-Dateien nimmt aufgrund der zu erkennenden, 
zu analysierenden und zu speichernden Daten ein wenig Zeit in Anspruch. Dieser Vorgang ist für jede 
Datei nur einmal nötig, da die Informationen gleichermaßen in der Media Library und der 
entsprechenden .OMX-Datei gespeichert werden. Importierte Dateien können sofort abgespielt 
werden, noch während die restlichen Dateien importiert werden. 
 
 
Verwaltung der Media Library-Kategorien 
Als Anwender haben Sie die vollständige Kontrolle über alle Media Library-Kategorien. 
 
Media Library ermöglicht die Erstellung von 128 Kategorien. Ein gewähltes Objekt kann jeder 
beliebigen Kategorie oder einer Kombination von Kategorien zugeordnet werden. 
 
In der Grundeinstellung verfügt OtsDJ über 7 voreingestellte Kategorien, von denen fünf in der zweiten 
Zeile der Media Library angezeigt werden. Diese Kategorien können nach Wunsch verwendet oder 
umbenannt werden. Die Benennung der Kategorien bleibt Ihrer Fantasie überlassen; es empfiehlt sich 
aber, keine Leer- oder Satzzeichen zu verwenden. Kategorien können aus der zweiten Zeile des Media 
Library-Bereichs entfernt oder derselben hinzugefügt werden. Alle Kategorien können über die Media 
Library Query Box geöffnet werden.  
   
Wenn Sie OtsDJ zum ersten Mal benutzen oder erweiterte Suchfunktionen (beispielsweise, um alle 
Lieder mit 120 bpm, die gleichzeitig in den Kategorien "Pop" und "Rock" enthalten sind, zu finden), 
bietet Ihnen die OtsDJ Online-Hilfe eine ausführliche Beschreibung des Ots Media Library-
Kategoriesystems. 
  
 
Um das Dialogfenster Manage Categories zu öffnen, wählen Sie Edit -> Manage Categories... im 
Programm-Menü. 
  
  
Erstellen einer neuen Kategorie 

• Klicken Sie auf  Edit -> Manage Categories.... Hierdurch wird das Dialogfenster Manage 
Categories geöffnet. 

• Klicken Sie auf New.... 
• Geben Sie einen Namen für eine neue Kategorie ein; z.B. Latin.  

Hinweis: Wir empfehlen Ihnen, keine Leer- oder Satzzeichen zu verwenden. Dieser Vorschlag 
ist jedoch nicht bindend. 

• Klicken Sie auf OK. 
  
 
Anzeigen der Kategorien in Media Library 
Die ersten fünf Kategorien im Manage Categories-Dialogfenster werden in der zweiten Zeile des 
Media Library-Bereichs angezeigt. Sie können Kategorien aus dieser Zeile entfernen oder hinzufügen. 

• Klicken Sie auf Edit -> Manage Categories... Hierdurch wird das Dialogfenster Manage 
Categories geöffnet. 

• Klicken Sie auf die Kategorie, die Sie verschieben möchten (die Kategorie sollte daraufhin 
hervorgehoben sein).  

• Klicken Sie auf Move up, um die Kategorie in der Liste nach oben zu bewegen, bis sie sich auf 
einer der ersten fünf Positionen befindet. 

• Klicken Sie auf OK. 
• Betrachten Sie den Media Library-Bereich. 

Tipp: Alle Kategorien können über das Query Dropdown-Menü im Media Library-Bereich 
geöffnet werden.  
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Einordnung Ihrer Musik 
Sobald Sie Ihre Mediendateien in OtsDJ importiert haben, können Sie Ihre Sammlung ganz einfach in 
verschiedene Kategorien einordnen. Hierzu bietet Ihnen Media Library drei Möglichkeiten. 
 

1) Manuelle Einordnung: Hiermit können Sie Ots Album-, Wave- oder MP3-Dateien manuell in 
Kategorien einordnen. Informationen hierzu finden Sie in den folgenden Abschnitten. 

 
2) Halbautomatische Einordnung: Ots Album- oder MP3-Dateien werden halbautomatisch nach 

den in den Dateien enthaltenen Informationen zu Genre oder Erscheinungsdatum eingeordnet. 
Informationen hierzu finden Sie in den folgenden Abschnitten. 

 
3) Einordnung basierend auf der Ordnerstruktur Ihrer Festplatte: Wenn Sie auf Ihrer Festplatte 

Ordner für die Kategorien erstellt und darin Dateien gespeichert haben, können Sie die 
Ordnerstruktur ganz einfach in Media Library festlegen. Informationen hierzu finden Sie in den 
folgenden Abschnitten. 

 
Ots Album-, Wave-, oder MP3-Dateien können aus einer oder allen Kategorien gelöscht werden, falls 
erforderlich. 
 
 
Manuelle Einordnung 
Die manuelle Einordnung umfasst die Erstellung neuer Kategorien, sofern diese nicht bereits bestehen, 
sowie die Zuweisung der Ots Album-, Wave- oder MP3-Dateien zu den erstellten Kategorien. 
Hinweise zur Erstellung und Verwaltung von Kategorien finden Sie weiter oben. 
 
 
Hinzufügen eines Objekts zu einer Kategorie 
Verwenden Sie diese Methode zur Einordnung von Wave-, MP3- und Ots-Objekten. 
 

Ots-Objekt Wave-Objekt MP3-Objekt 

   
 

• Wählen Sie das Register All Items im Media Library-Bereich. 
• Wählen Sie ein oder mehrere Objekte, die Sie einordnen möchten. 
• Klicken Sie mit der rechten Maustaste und wählen Sie Category -> Add to ->, um die 

Kategorie auszuwählen, der Sie das Objekt hinzufügen möchten. Hierauf wird die Datei der 
gewählten Kategorie zugeordnet. 

 
 
Hinzufügen eines Albums zu einer Kategorie 
Verwenden Sie diese Methode, um eine komplette Ots Album-Datei oder einzelne MP3- und Wave-
Dateien einzuordnen. 
 

Ots Album Wave-Datei MP3-Datei 

   
 

• Wählen Sie das Register Albums im Media Library-Bereich. 
• Wählen Sie ein oder mehrere Alben, die Sie einordnen möchten. 
• Klicken Sie mit der rechten Maustaste und wählen Sie Category -> Add to ->, um die 

Kategorie auszuwählen, der das Album hinzugefügt werden soll. Hierauf wird die folgende 
Meldung angezeigt:  
 "This operation will affect all individual items contained within the album(s) you have selected. 
Do you wish to proceed?" 
 

• Klicken Sie auf Ja. 
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Halbautomatische Einordnung 
Sofern Sie Ihre Ots Album- oder MP3 (ID3v1-Tag)-Dateien mit Angaben zu Genre und 
Erscheinungsdatum versehen haben, können Sie diese leicht anhand dieser Informationen einordnen. 
 
Klicken Sie hierzu einfach mit der rechten Maustaste auf das Album oder Objekt und wählen Sie 
die Option Category -> Assign by.... 
 
OtsDJ erstellt neue Kategorien anhand der in Ihren Dateien enthaltenen Informationen zu Genre und 
Erscheinungsdatum und ordnet die Dateien den Kategorien zu.  
 
Beispiel: 

Wenn Sie das Genre Rock im Genre-Eingabefeld eingegeben haben, wird die Kategorie 
Rock erstellt und die Datei der Kategorie Rock zu geordnet. 
 
Wenn Sie 1981 in das Release-Eingabefeld der Datei eingegeben haben, wird die Kategorie 
1980s erstellt und die Datei der Kategorie 1980s zu geordnet. 
 
 

Einordnung von Objekten nach Genre oder Erscheinungsdatum 
Sie können ein Objekt anhand der darin enthaltenen Angaben zu Genre oder Erscheinungsdatum 
einordnen.  
 
Hinweis: Diese Methode kann für Ots- und MP3-Dateien (mit ID3v1-Tags), die Angaben zu Genre 
und Erscheinungsdatum enthalten, verwendet werden. 
  

Ots-Objekt MP3-Objekt 

  
 

• Wählen Sie ein oder mehrere Objekte, die Sie einordnen möchten. 
• Klicken Sie mit der rechten Maustaste darauf, wählen Sie Category -> und anschließend 

entweder Assign by Genre Info... oder Assign by Release Info.... Hierauf wird die folgende 
Meldung angezeigt: 
 "This operation will add all selected items to categories based upon their genre. You will be 
prompted before any new categories are created. Do you wish to continue?" 

 
• Klicken Sie auf Ja. 
• Im Anschluss wird das Dialogfenster Create new category? geöffnet. 
• Wenn Sie mit der neuen Kategorie einverstanden sind, klicken Sie auf Ja. 

 
 
Einordnung von Alben nach Genre oder Erscheinungdatum  
Sie können auch ein komplettes Album anhand der Angaben zu Genre und Erscheinungsdatum der 
darin enthaltenen Objekte einordnen. 
 
Hinweis: Die Alben selber können keiner Kategorie zugeordnet werden, lediglich die darin enthaltenen 
Objekte lassen sich einordnen. Der in diesem Abschnitt beschriebene Prozess ist daher lediglich ein 
einfaches Verfahren, um die in einem Album enthaltenen Objekte einzuordnen. 
 

Ots-Album MP3-Datei 

  
 

• Wählen Sie das Register Albums im Media Library-Bereich. 
• Wählen Sie ein oder mehrere Alben, die Sie einordnen möchten. 
• Klicken Sie mit der rechten Maustaste darauf, wählen Sie Category -> und anschließend 

entweder Assign by Genre Info... oder Assign by Release Info.... Hierauf wird die folgende 
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Meldung angezeigt: 
 "This operation will affect all individual items contained within the album(s) you have selected. 
Do you wish to proceed?" 

 
• Klicken Sie auf Ja. Die folgende Meldung wird eingeblendet:  

 "This operation will add all selected items to categories based upon their (Genre or Release 
Info). You will be prompted before any new categories are created. Do you wish to continue?"  

 
• Klicken Sie auf Ja. 
• Hierdurch wird das Dialogfenster Create new category? geöffnet. 
• Wenn Sie mit der neuen Kategorie einverstanden sind, klicken Sie auf Ja. 

 
 
Einordnung auf der Grundlage der Ordnerstruktur 
Wenn Sie Ihre Dateien in Kategorie-Ordnern auf Ihrer Festplatte gespeichert haben, können Sie diese 
Struktur ganz einfach in der Media Library festlegen. Dieser Vorgang umfasst drei einfache Schritte: 
 

1) Erstellen Sie die Kategorien in OtsDJ, um die Ordner auf Ihrer Festplatte anzuzeigen. Hinweise 
zur Erstellung von Kategorien finden Sie in den vorigen Abschnitten. 

 
2) Importieren Sie Ihre Dateien in Media Library. Hinweise zum Import von Dateien finden Sie in 

den vorigen Abschnitten. 
 

3) Fügen Sie die Dateien dem Ordner der entsprechenden Kategorie hinzu: 
 

• Wählen Sie File -> Media Library Folder Structure im OtsDJ Programm-Menü. 
• Klicken Sie doppelt auf den Ordner im Media Library Structure-Dialogfenster. Alle in diesem 

Ordner enthaltenen Dateien werden nun im Media Library-Bereich angezeigt. 
• Klicken Sie mit der rechten Maustaste in den Media Library-Bereich. 
• Wählen Sie die Option Select -> All. 
• Klicken Sie mit der rechten Maustaste, klicken Sie auf Category -> Add to -> und wählen Sie 

die Kategorie, der die Dateien zugeordnet werden sollen. 
• Wenn Sie fortfahren wollen, klicken Sie im Dialogfenster auf Ja. Hierdurch werden alle in dem 

Ordner enthaltenen Dateien der entsprechenden Kategorie in Ihrer Media Library zu geordnet. 
• Wählen Sie die Kategorie im Query Dropdown-Menü, um die hinzugefügten Objekte 

anzuzeigen. 
 
 
Entfernen eines Objekts aus einer Kategorie 

• Wählen Sie das Objekt, das Sie aus einer Kategorie entfernen wollen. 
• Klicken Sie mit der rechten Maustaste darauf, klicken Sie auf Category -> Remove from -> und 

wählen Sie die Kategorie, aus der Sie das Objekt entfernen möchten. 
 

Tipp: Um ein Objekt aus allen Media Library-Kategorien zu entfernen, wählen Sie Category -> 
Remove from All. 

 
 
Entfernen eines Albums aus einer Kategorie 

• Wählen Sie das Register Album im Media Library-Bereich. 
• Wählen Sie das Album, das Sie aus einer Kategorie entfernen möchten.    
• Klicken Sie mit der rechten Maustaste darauf, klicken Sie auf Category -> Remove from -> und 

wählen Sie die Kategorie, aus der Sie das Album entfernen möchten. 
 

Tipp: Um ein Album aus allen Media Library-Kategorien zu entfernen, wählen Sie Category -> 
Remove from All. 
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Playlist-Erstellung und Optionen  
Eine Playlist oder ein Playlist-Segment ist eine Liste von Objekten bzw. Direktiven, die in einer 
bestimmten Reihenfolge angeordnet sind. Diese Objekte können Ots Album-Objekte, Wave-Dateien 
oder MP3-Dateien, CD Audio-Tracks oder Direktiven sein. Wenn die Playlist geöffnet wird, werden 
alle darin enthaltenen Objekte in ein Deck geladen und in der vorgegebenen Reihenfolge abgespielt. 
Innerhalb der Playlist vorhandene Direktiven kontrollieren oder beeinflussen den Ablauf der Playlist 
oder bieten Zugang zu weiteren Funktionaliäten. 
 
Eine Playlist kann eine beliebige Anzahl an Objekten enthalten und eine unterschiedliche Länge 
(Gesamtdauer der Abspielzeit aller Objekte) haben. Ein Playlist-Segment ist im Allgemeinen eine 
kurze Playlist mit einer bestimmten Anzahl von Objekten und einer Abspielzeit, die meistens eine 
Stunde beträgt. Diese Segmente dienen als Grundlage für die Erstellung längerer Playlists. 
 
Playlist-Segmente werden hauptsächlich von Radiosendern und anderen Anwendern, die besondere 
Anforderungen an die zeitliche Planung haben, verwendet. Aus diesem Grund wird in diesem 
Abschnitt nicht näher auf die Segmente eingegangen. Weitere Informationen hierzu finden Sie in der 
Online-Hilfe für das Scheduling & Logging-Modul. 
 
Playlists können: 

• automatisch beim Start des Programms generiert werden, 
• generiert werden, während OtsDJ geöffnet ist, 
• in einen Zeitplan für einen vordefinierten Zweck integriert werden, 
• während das Programm läuft hinzugefügt und bearbeitet werden, 
• zu jedem Zeitpunkt geändert werden, auch wenn der nächste Titel auf der Liste kurz darauf 

abgespielt wird, 
• manuell (von Hand) oder automatisch durch den Playlist-Generator aufgrund einer Playlist-

Schablone erstellt werden. 
 
Ein Playlist-Template (Template = Schablone) ist eine Programmiersprache, die dem Playlist 
Generator vorschreibt, wie er eine Playlist erstellen soll. Sie können den Template Builder verwenden, 
um Playlist Templates zu erstellen. Weitere Informationen hierzu finden Sie in der OtsDJ Online-Hilfe. 
 
Wenn Sie alle Funktionen und Möglichkeiten des Playlist Generators nutzen möchten, lesen Sie die 
Playlist-Template Dokumentation. Weitere Hinweise hierzu finden Sie in der OtsDJ Online-Hilfe.  
 
 
Erstellung einer allgemeinen Playlist 
Die folgende Playlist-Schablone erstellt eine zweistündige Playlist mit Objekten aus all Ihren Media 
Library-Kategorien. 

• Klicken Sie auf das   Symbol in der Tool-Leiste. 
• Im Bereich Action vergewissern Sie sich, dass die Option Replace Existing Playlist aktiviert ist. 
• Im Bereich Options vergewissern Sie sich, dass die Optionen Clear History und Auto Play 

After Generate aktiviert sind. 
• Klicken Sie auf Generate.... OtsDJ erstellt nun eine allgemeine Playlist und spielt diese ab.  

 
Um zu lernen, die Erstellung der Playlists Ihren eigenen Anforderungen anzupassen, benutzen Sie den  
Playlist Template Builder und lesen Sie die OtsDJ Online-Hilfe. 
 
 
Manuelle Erstellung einer Playlist 
Sie können eine Playlist auch manuell erstellen, indem Sie die gewünschten Objekte oder Alben im 
Playlist-Bereich platzieren.  
Bevor Sie mit der manuellen Darstellung beginnen, müssen Sie den Playlist-Bereich möglicherweise 
erst leeren.  
 
So leeren Sie den Playlist-Bereich: 

• Klicken Sie mit der rechten Maustaste und wählen Sie die Option Select -> All. 
• Klicken Sie mit der rechten Maustaste und wählen Sie die Option Delete from list. 
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Zunächst müssen Sie das Objekt oder Album, das Sie der Playlist hinzufügen möchten, finden. OtsDJ 
verfügt über eine Reihe von Funktionen, die Ihnen helfen, Objekte oder Alben schnell zu finden.  
 
Sie können: 

• ein Objekt aus einer Kategorie oder der Media Library-Liste auswählen. Sobald Sie das 
gewünschte Objekt gefunden haben, können Sie es entweder per Drag & Drop oder durch 
Kopieren und Einfügen in die Playlist kopieren (benutzen Sie die Rechtsklick-Option für das 
Kopieren und Einfügen); 

• ein Album aus der Albums-Liste im Media Library-Bereich auswählen. Sobald Sie das 
gewünschte Album gefunden haben, können Sie es entweder per Drag & Drop oder durch 
Kopieren und Einfügen in die Playlist kopieren (benutzen Sie die Rechtsklick-Option für das 
Kopieren und Einfügen). Wenn Sie ein Album in der Playlist platzieren, werden alle darin 
enthaltenen Objekte in diese Liste kopiert; 

• die gesamte Media Library mithilfe des Search Media Library-Tools nach einem Objekt (oder 
Album) durchsuchen. Sobald Sie das gewünschte Objekt gefunden haben, können Sie entweder 
die Kopierfunktion nutzen oder das Objekt per Drag & Drop oder Kopieren und Einfügen 
(Rechtsklick) in der Liste platzieren;  

• das Find in List-Tool benutzen, um in einer Liste nach dem gewünschten Objekt zu suchen. 
Hierbei kann es sich um eine Liste in der Media Library, im Arbeitsbereich (Work Area) oder,im 
History-Liste um die Playlist selber handeln. Sobald Sie das gewünschte Objekt gefunden haben, 
können Sie entweder die Kopierfunktion nutzen oder das Objekt per Drag & Drop oder Kopieren 
und Einfügen (Rechtsklick) in der Liste platzieren.  

• Suchanfragen in der Ots Media Query Language (OMQL) in die Media Library Query Box 
eingeben und erhalten sofort ein Ergebnis. Sobald Sie das gewünschte Objekt gefunden haben, 
können Sie entweder die Kopierfunktion nutzen oder das Objekt per Drag & Drop oder Kopieren 
und Einfügen (Rechtsklick) in der Liste platzieren;  

• Sobald Sie eine Playlist erstellt haben, können Sie dieselbe für den späteren Gebrauch 
abspeichern. Informationen zum Speichern und Laden von Playlists finden Sie in der OtsDJ 
Online-Hilfe. 

 
Heißer Tipp: Der Arbeitsbereich (Work Area) ist ein hervorragendes Werkzeug für das Hinzufügen 
und Löschen von Objekten in einer Playlist. Dieser Bereich ist eine ideale Zwischenablage für die 
Übertragung von Objekten aus einer Playlist oder Titelanfragen. 
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Hercules DJ Steuerung mit OtsDJ 
Im Folgenden finden Sie eine Tabelle der Hercules DJ Steuerung mit OtsDJ. 
 

Hinweis: Die linke und rechte Maustaste auf dem Controller werden als Shift-Tasten verwendet. In den meisten 
Fällen haben die rechte und linke Taste die gleiche Funktion; für einige Steuerungs-Optionen haben die beiden 
Tasten jedoch eine unterschiedliche Funktion (Maustasten). Wenn in den folgenden Abschnitten der Begriff 
"Shift" verwendet wird, bedeutet dies, dass Sie beide Tasten benutzen können, wohingegen sich die Begriffe 
"rechte Shift-Taste" und "linke Shift-Taste" auf eine bestimmte Taste beziehen. 

 
Steuerung Funkion 

Play/Pause Übliche Standardfunktion 

Cue Übliche Standardfunktion 

Next Track Übliche Funktion. Der nächste Titel der Wiedergabeliste wird geladen. 

Shift + Next Track Blendet den aktuellen Track aus und spielt den folgenden Titel ab. 

Previous Track Wählt den vorherigen Track aus. 

Crossfader  Übliche Funktion. 

Linke Shift-Taste + 
Crossfader 

Zentriert den Crossfader. 

Rechte Shift-Taste + 
Crossfader 

Verschiebt den Crossfader ganz nach links oder rechts, je nachdem, in welche Richtung 
derselbe bewegt wird. 

Pitch Bend Übliche Funktion. Beachten Sie, dass Ots die "Tempo bend"- (Grundeinstellung) und 
"Pitch bend"-Funktion unterstützt. 

Autobeat Aktiviert/Deaktiviert den "On Air"-Kanal des gewählten Decks. 

Monitor  Übliche Funktion. Aktiviert/Deaktiviert den Cue-Kanal für das gewählte Deck. 

FX/Cue/Loop Wechsel zwischen "Pitch"-, "Tempo"- und "Direction"-Modus. 

Pitch Schieberegler Reguliert Pitch, Tempo und Richtung je nach gewähltem Modus. 

Rechte und linke Shift-
Taste + Pitch 
Schieberegler 

Stellt Pitch und Tempo auf die mittlere Position oder auf 100% vorwärts oder 
rückwärts ein (im Direction-Modus und durch Drücken der rechten Shift-Taste). 
  

Jog  Überspringt +/- einen Frame im "Frame-Seek-Cueing"-Modus. 

Shift + Jog Überspringt +/- zehn Frames im "Frame-Seek-Cueing"-Modus, oder Kratzer die CD 
Track (Linksverschiebung ist normal Kratzer, Rechtverschiebung verkratzend, ist "sich 
verfangen-oben" Verkratzen Modus). 

Master Tempo (links) Ein- und Ausschalten des AutoDJ Modus. 

Master Tempo (rechts) Ein- und Ausschalten des Live Input-Modus. 

Volume Übliche Funktion. Reguliert die Lautstärke des Turntables. 

Bass Regulierung der Bässe des Turntables 

Mid Regulierung des mittleren Frequenzbereichs des Turntables 

Treble Regulierung der Höhen des Turntables 

Effect 1 Zeigt die Scratch-Liste für dieses Deck in der mittleren Bildschirmleiste an. 

Effect 2 (links) Zeigt das Mischpult in der mittleren Bildschirmleiste an. 

Effect 3  Zeigt das CD-Cover in der mittleren Bildschirmleiste an. 

Shift + Effect 1/2/3 Spielt einen integrierten Scratch-Effekt für dieses Deck ab. 
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Tastatur-Shortcuts 
Die folgende Liste bietet eine Übersicht der in OtsDJ verfügbaren Tastatur-Shortcuts. 
 

Menü-Tasten 
 

Taste Aktion 

Alt + F Öffnet das Programm-Menü. 

Alt + E Öffnet das Menü "Edit". 

Alt + V Öffnet das Menü "View". 

Alt + C Öffnet das Menü "Control". 

Alt + O Öffnet das Menü "Options". 

Alt + H Öffnet das Menü "Help". 

 
 

Auto DJ-Tasten 
 

Taste Aktion 

Strg + A Auto DJ ein- und ausschalten.  

 
 

Live Input-Tasten 
 

Taste Aktion 

Strg + M Live Input ein- und ausschalten 

 
 

Tastatur Shortcuts für Deck A 
 

Tastenkombinationen F1 F2 F3 F4 
  Stop / Zum 

nächsten Cue 
Point springen 

Abspielen Dämpfen 
(Tempo/Pitch) 

Erhöhen 
(Tempo/Pitch) 

Shift Ausblenden   
Strg Startpunkt 

suchen 
Cue Point 
festlegen 

Rückwärts 
suchen 
(1 Frame) 

Vorwärts suchen 
(1 Frame) 

Strg+Shift Auswerfen Nächster 
Track 

Rückwärts 
suchen 
(10 Frames) 

Vorwärts suchen 
(10 Frames) 

Alt Pitch senken 
(0,5%) 

Pitch 
erhöhen 
(0,5%) 

Tempo senken 
(0,5%) 

Tempo erhöhen 
(0,5%) 

Alt+Shift Pitch senken 
(0,1%) 

Pitch 
erhöhen 
(0,1%) 
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Tastatur Shortcuts für Deck B 
 

Tastenkombinationen F5 F6 F7 F8 
  Stop/ Zum 

nächsten Cue 
Point 
springen 

Abspielen Dämpfen 
(Tempo/Pitch) 

Erhöhen 
(Tempo/Pitch) 

Shift Ausblenden   
Strg Startpunkt 

suchen 
Cue Point 
festlegen 

Rückwärts 
suchen 
(1 Frame) 

Vorwärts suchen 
(1 Frame) 

Strg+Shift Auswerfen Nächster Track Rückwärts 
suchen (10 
Frames) 

Vorwärts suchen 
(10 Frames) 

Alt Pitch senken 
(0,5%) 

Pitch erhöhen 
(0,5%) 

Tempo senken 
(0,5%) 

Tempo erhöhen 
(0,5%) 

Alt+Shift Pitch senken 
(0,1%) 

Pitch erhöhen 
(0,1%) 

  

 
 
Tipp: So lesen Sie die Tastatur-Shortcut Tabelle: Suchen Sie die Funktion, die Sie ausführen möchten 
und lesen Sie die entsprechende Tastenangabe in der linken Spalte. Wenn Sie zum Beispiel die 
Auswerfen-Funktion suchen, finden Sie in der linken Spalte die Angabe Strg + Shift und in der 
Kopfzeile die Angabe F1. Wenn Sie jetzt Strg + Shift und anschließend F1 drücken, wird das aktuelle, 
in Deck A wiedergegebene Objekt ausgeworfen.    
 

Pitch/Tempo Bending-Tasten 
 

  Deck A 

Taste Aktion 

F3 Senken (Tempo/Pitch) 

F4 Erhöhen (Tempo/Pitch) 

    

  Deck B 

Taste Aktion 

F7 Senken (Tempo/Pitch) 

F8 Erhöhen (Tempo/Pitch) 

 
 



OtsDJ Quick Start-Handbuch 
 

© Ots Corporation 1996 - 2003 
 

16 

Scratch Sample Tasten 
 

Tasten Aktion 

F9 Adam's erster Scratch! 

F10 Adam's zweiter Scratch! 

F11 Benutzerdefinierter Scratch Sample 

F12 Benutzerdefinierter Scratch Sample 

 
Crossfader-Zifferntasten 

 
Taste Aktion 

7 Überblenden auf Turntable A. 

8 Ausblenden auf mittlere Position. 

9 Überblenden auf  Turntable B 

  

4 Schnell überblenden auf Turntable A 

5 Schnell ausblenden auf mittlere 
Position 

6 Schnell überblenden auf Turntable B. 

  

1 Langsam überblenden auf Turntable A 

2 Langsam überblenden auf mittlere 
Position 

3 Langsam überblenden auf Turntable B 

  

0 Schrittweise ausblenden nach links 

Del Schrittweise ausblenden nach rechts 

 
Hinweis: Zur Nutzung der Crossfader-Funktion muss die Num Lock-Option der Tastatur aktiviert 
sein.  
 
 

Visualizations-OtsDJ Tasten 
 

Taste Aktion 
Pfeil links Blendet den aktuellen Track aus und spielt den vorigen 

Track ab. 
Pfeil 
rechts 

Blendet den aktuellen Track aus und spielt den nächsten 
Track des anderen Decks oder der Playlist ab.   

Pfeil 
aufwärts 

Startet den F9 Scratch-Sample. 

Pfeil 
abwärts 

Unterbricht den vom aktuellen Deck abgespielten Track 
(Pause-Funktion). 

 



OtsDJ Quick Start-Handbuch 
 

© Ots Corporation 1996 - 2003 
 

17 

Index 
.mp3 files ................................................................................................................................................................... 5 
.wav files.................................................................................................................................................................... 5 

A 

Adding Albums to a category .................................................................................................................................... 8 
Adding Albums to a playlist .................................................................................................................................... 11 
Adding Items to a category ........................................................................................................................................ 8 
Adding Items to a playlist ........................................................................................................................................ 11 
Assign by Genre Info... .............................................................................................................................................. 9 
Assign by Release Info... ........................................................................................................................................... 9 
Auto DJ Keys........................................................................................................................................................... 14 

B 

Building a playlist manually .................................................................................................................................... 11 
Building your Media Library ..................................................................................................................................... 5 

C 

Catalog system........................................................................................................................................................... 5 
Categories .................................................................................................................................................................. 7 
creating a new Category............................................................................................................................................. 7 
displaying categories in Media Library area .............................................................................................................. 7 
Categorizing your music ............................................................................................................................................ 8 
adding Files to categories........................................................................................................................................... 8 
adding Items to categories ......................................................................................................................................... 8 
adding Ots Albums to categories ............................................................................................................................... 8 
assign by Genre Info... ............................................................................................................................................... 9 
assign by Release Info... ............................................................................................................................................ 9 
based on folder structure.......................................................................................................................................... 10 
Category system......................................................................................................................................................... 5 
Change categories ...................................................................................................................................................... 7 
Clearing the Playlist area ......................................................................................................................................... 11 
Create a new Category ............................................................................................................................................... 7 

D 

Displaying categories in the Media Library............................................................................................................... 7 
Drag and Drop 
manually building a playlist..................................................................................................................................... 11 

F 

File formats................................................................................................................................................................ 4 
Files - importing ........................................................................................................................................................ 5 
Folders - categorizing based on structure................................................................................................................. 10 
Formats - supported file formats................................................................................................................................ 4 

G 

Generating a playlist ................................................................................................................................................ 11 
generating a generic playlist .................................................................................................................................... 11 
generating a playlist manually ................................................................................................................................. 11 
Generic playlist........................................................................................................................................................ 11 
Getting Started ........................................................................................................................................................... 1 

I 

Import/Refresh File(s)................................................................................................................................................ 6 
Importing ................................................................................................................................................................... 5 
importing File(s) ........................................................................................................................................................ 6 
Install 
installing OtsDJ ......................................................................................................................................................... 2 
installing OtsDJ Demo............................................................................................................................................... 2 

K 

Keyboard shortcuts .................................................................................................................................................. 14 

L 

Library system ........................................................................................................................................................... 5 
Licensing Ots products .............................................................................................................................................. 3 



OtsDJ Quick Start-Handbuch 
 

© Ots Corporation 1996 - 2003 
 

18 

licensing an internet-connected machine ................................................................................................................... 3 
List generation ......................................................................................................................................................... 11 
Loading Ots files........................................................................................................................................................ 5 

M 

Managing Media Library categories .......................................................................................................................... 7 
Manually building a playlist .................................................................................................................................... 11 
Mapping folder structure.......................................................................................................................................... 10 
Media formats ............................................................................................................................................................ 4 
Media Library ............................................................................................................................................................ 5 
building your Media Library...................................................................................................................................... 5 
importing files............................................................................................................................................................ 5 
Media Library Folder Structure ............................................................................................................................... 10 
Mixer keys ............................................................................................................................................................... 14 
Moving categories...................................................................................................................................................... 7 
MP3 files.................................................................................................................................................................... 4 
importing Files to the Media Library ......................................................................................................................... 5 
Music - Importing ...................................................................................................................................................... 5 
Music files ................................................................................................................................................................. 4 

N 

New Category ............................................................................................................................................................ 7 

O 

OMX file.................................................................................................................................................................... 5 
Ots Album file 
importing Ots Album files ......................................................................................................................................... 5 
Ots Media Extension (.OMX) file.............................................................................................................................. 5 
Ots Studio 
licensing Ots Studio ................................................................................................................................................... 3 

P 

Pitch/Tempo bending keys....................................................................................................................................... 14 
Playlist generation.................................................................................................................................................... 11 
clearing a playlist ..................................................................................................................................................... 11 
generating a generic playlist .................................................................................................................................... 11 
generating a playlist manually ................................................................................................................................. 11 
Playlist Generator .................................................................................................................................................... 11 
Playlist options......................................................................................................................................................... 11 
Playlist segment ....................................................................................................................................................... 11 

R 

Registration................................................................................................................................................................ 3 
Removing an Album from a category...................................................................................................................... 10 
Removing an Item from a category.......................................................................................................................... 10 

S 

Scheduling module 
licensing the Scheduling module ............................................................................................................................... 3 
Scratch Sample Keys ............................................................................................................................................... 14 
Shortcuts .................................................................................................................................................................. 14 
Specifications............................................................................................................................................................. 2 
System requirements.................................................................................................................................................. 2 

T 

Turntable Keyboard Shortcuts ................................................................................................................................. 14 
Turntable Keys......................................................................................................................................................... 14 

W 

Wave files .................................................................................................................................................................. 4 
importing Files to the Media Library ......................................................................................................................... 5 

X 

X-Fader Numeric Keys ............................................................................................................................................ 14 
 


